D9010UDAA A

User Defined Application for DCA, Infiniilum and InfiniiVision Oscilloscopes

UDA is an easy-to-use tool that lets you generate custom GUIs for test
automation applications with minimum programming. You can automate
testing, generate reports, test consistently across your organization, control
switch matrices for multi-lane testing, all while adding analysis to your
compliance or debug software.

Learn more at: www.keysight.com
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Product Overview

Automated testing continues to be an extremely important part of today’s engineering environment. Today’s
oscilloscope vendors provide compliance applications such as USB 3.0, PCle, MIPI and DDR to provide
specific automation for the technology that you need to ensure certification of your design.

However, compliance applications were created specifically for the technology that you are designing.
These applications lacked the ability to be modified, which meant limited flexibility. Any custom automation
had to be done on your own with more complicated programming environments.

Keysight oscilloscopes now solve this problem with the User Defined Application (UDA). UDA is the only
fully customizable automated environment made for your oscilloscope. It provides full automation, including
the ability to control other Keysight instruments, external applications such as MATLAB, and your DUT
software. UDA also provides the ability to add custom tests to your Infinilum compliance applications. In
addition, UDA automates and customizes your multi-lane interface testing with a switch matrix. UDA
switches the signal under test from a multi-lane interface automatically, so you do not have to be in front of
the test setup to do this manually. It also supports the test plan feature, which iteratively runs through
different permutations of your device setup and tracks the results. It makes testing of multi-lane signals
more efficient and saves you time.

When working with  InfiniiVision

oscilloscopes, the UDA application User Defined InfiniVision. Test Report
executes on a Windows PC and uses AN EYSIGHT
a network or USB connection to fully Pass
Test Configuration Details
control and automate the test process. T Test Session Details
For DCA and Infiniium oscilloscopes, it Ittaseie—{ora
is optional to run on a separate PC or zsmste= e ee & G e

directly on the oscilloscope, giving you Summary Of Results

o sge . . Test Statistics Margin Thresholds
the flexibility to optimize your test [G= 0‘_‘_4| T —|
environment.
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The Development Environment
Developed for oscilloscope test

There are two key differentiators for UDA from programs such as Keysight's VEE. The first is that UDA was
designed specifically for Keysight oscilloscopes. The UDA development environment is easier to use than
other test and measurement automation packages, which allows you to spend less time programming and
more time testing your application. The second key differentiator is that the environment built around the
Infiniilum proprietary compliance testing framework, which gives you features developed for Infiniium’s
compliance testing and the customization you wanted. Other oscilloscope vendors may have compliance
applications or leverage development environments such as VEE; however, only Keysight oscilloscopes
have the added advantage of the flexibility and ease of use of UDA.

The development environment

File Edit Build Tools Help
Like other programming applications, UDA has DS E R (R E e
. . Set Up | Tests | Configs [ Connections | ines | Events | M | Debug Run | Buid | Automation |
its own development environment. The iniins
H Name: Set.
enV|ronm§nt can b(.a downloaded for free at — o — )
www.keysight.com/find/uda. PR —
InfiniiVision Platform | Product | Summary:
The UDA environment includes all the tabs that pmeneivoen ) @ Fecch I
. . . Fiters @ Infiniium
you would see in a typical compliance B ncudetosgoup | | © HrdVson o \
. . ["] Include option 4| ) Open Existing Project () Open Restore Point
application, however, you control the tests and erm— e e
automation that you need. paiii
| Manage || Nickname Socket Description ‘
To make developing simple and easy, the : - —
] Build Summary- Drag barto resize
development environment has two modes buid_[Fnd |
Ready InfiniiVision Application

(Basic and Advanced). Basic mode allows you
to quickly build an application. Tests written for
basic mode will load a single setup file and
execute a single script or command. You get
variable set up and can load your own

Figure 2. Keysight's UDA supports multiple oscilloscope types.

File Edit Build Tools Help
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Set Up |Tests | Configs | C: [ ines | Events | | Debug Run | Buid | Automation |
company logo. Aoplcation

Name: Infinium LVDS Display Measurement
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diagrams, external instrument control, external F—
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independent scripts running during testing. et

[¥] Enable control
Integration into oscilloscope user interface (limmmn] | M | Socn | Domction N

E3631A  False  Triple Output DC Power Supply 0-6V(5A)/0+-25(1A)

* Drag barto resize *

Once you have developed your UDA and
installed it on your oscilloscope, the application
is fully integrated into the FlexDCA or Infiniium Figure 3. Basic UDA development environment.
GUL. You run your UDA like any of Infiniium’s

best-in-class compliance applications. The

application can be found in the Analyze menu

under the automated test apps.

Ready Infiniium Application
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Complete variable control

UDA also allows you to set up and use
variables. This simplifies your programs. For
instance if you are using CHAN as the variable
for my oscilloscopes’ four channels, you can set
channel 1 as the default. Create variables that
are input by the user at run-time on the scope.

Building your program

Once you have completed your UDA you can
“‘generate” the application that you have
developed. There are four different options for
building your applications that include the
following:

e Build application
e Launch application (Works when you
are developing the UDA on your

oscilloscope. This will launch the
application on the oscilloscope).
e Generate installer (Generates the

application and generates a zipfile to be
downloaded and installed on your
oscilloscopes desktop).

e Install application (Works when you are
developing the UDA on your
oscilloscope. This will install everything
you need to run the UDA. When you
use this option, the application is
permanently installed on  your
oscilloscope).

At any time during the development of your
application you can do a “debug” run, which
allows you to check for any errors, such as a file
not existing or a path being incorrect. Debug
runs also can check to see if any external
instruments you are controlling can be found.

Config

Displayed Name: Acquisition Points
Variable Name: ;'cAcquisitionPoimis

Description:

Acquisiion Points(in the menu under Setup->Acquistion)

Choices

100000 (100000)
200000 (200000) (Default)
(500000)

— ) | 500000
| | 1000000 (1000000)

Options
DebugRun Value:
[T] During a run, prompt to change connection when this config changes

200000

[] Allow user to select muttiple choices simultaneous! auto-teration
[ Min gnclusive):
[] Max Ginclusive): :

[] Show only when Generated Application is in Debug Mode

Allow user to add new choices

{Menu: Tools > DebugRun)

Figure 4. Setting up variables.

File Edit Build Tools Help

DEFH R < EEE S E e
Set Up [ Tests [ Configs | C: jons | ines | Events | M | Debug Run | Buid |

Build Launch
Copies user files to intemal cache and builds. Build and run the application now.
Build Application Launch Application

Allow installation on PC
Instal Generate Installer
Builds the application and installs on this
ine now. Use Infinilum’s Analyze >
Apps menu to launch application.

Build the application and generate an installer.
(Copy file to scope and execute it )

Install Application ] [ oo e il

File saved to:

Build Summary:

“ Drag barto resize *

Buid | Find

Ready Infiniium Application

Figure 5. Four different options to build your program.
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Application Integration
Infiniilum analysis software

. . . N Select Step T = | =
UDA is fully compatible with all the DCA, Infiniium and B et Step Typ GG
InfiniiVision oscilloscope applications via SCPI commands. TR D IDEIE

. A . R . 3 Initial Conditions Run Cortrol
This compatibility includes Infiniium applications such as ©) Defaut Scope Setup © Moot

Serial Data Equalization, Serial Data Analysis, EZJIT Plus,

() Load Scope Setup File

() Display Message

InfiniiSim and InfiniiScan. By combining UDA with these e e R
Lo i . () Single SCPI Command ) Pause
Infiniium applications, you can get exactly the automated © SCPI Command Fie © Sew
analysis that you need. For example, you can create a © Load Soope Mask File ©) Vedfy condition
() Apply Transfer Function () Get SCPI Emor

UDA to find which equalization algorithm will open your eye

() Use Console Application
() Launch Extemal Application

() Clear SCP| Emor Cache

the best. Simply combine UDA with the Serial Data . F'ijorﬂmI
Equalization and the eye height measurement, and you can SRR . m
quickly find the filter you need for the optimal filter design. © Witeto Fie S
Not only will you know which tap values to use, but you will © Tranfer Egtemal e © End()
also have your customized HTML report to show it. e e © "““'h'E':i

o . . oL (©) HTML Table & Cortinue
In addition to working with all other Infiniium software, UDA P— R,
is fully compatible with MATLAB and Infiniium’s User- ©) Comment i

Defined Function, which allows you unprecedented flexibility
in your measurement capability and in your automation
software. UDA even allows you to import MATLAB graphics
into your user-defined application report.

Use your add-in capability to create tests that unlock the

power of de-embedding and your application. Compliance applications may allow you to de-embed a fixture,

Cancel

Figure 6. Options of what can be added to a
UDA test routine.

but UDA allows you to show the improvement in your design by removing the cable and the fixture.

Compliance test add-ins

In UDA version 2.50 and later, you can create test add-ins. A test add-in can be added to your DCA,
Infiniium or InfiniiVision compliance application, such as USB Signal Quality Testing or PCle Gen3. This
capability now allows you to test to the exact compliance specification and then create additional
customized automation tests through UDA and test them all in the same report. This now gives you the
unmatched combination of the ease of use of compliance applications and the flexibility customized
technologies. There is no other tool in the oscilloscope industry that allows this combination.

External applications

TS T TR I

Stlilloeeslfotn] arsston] sl ] s it One of the most advanced features of UDA is the ability to run
i L e any external application to your UDA. You can create a script
e coreo from VBA or C# and then execute it into the UDA application.
- This allows you to add customizable consoles.
g“m”;ﬁmmmmmmm Figure 7 shows a UDA that was created for setting up testing

3 of SDI (serial data interface). The VBA example occurs at run
— - time and allows the user to test to the exact conditions the
lw s | user wishes for testing.
Ready Infinilum Application B |

Figure 7. Easily debug as you create custom
applications.
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Switch matrix

The custom switch matrix software option for
UDA used together with switch matrix hardware
provides automated and customizable testing
for multi-lane digital bus interfaces. The benefits
of the automated switching solution include:

e Eliminate reconnections—which saves
time and reduces errors through
automating test for each lane of a

e multi-lane bus.

e Maintain accuracy—with the use of
unique PrecisionProbe or InfiniiSim to
compensate switch path losses and
skew.

e Customize testing—with the use of
remote programming interface and
UDA for device control, instrument
control and test customization.

More on the solution and configuration can be
found at http://www.keysight.com/find/switching
and Using Microwave Switches When Testing
High Speed Digital Interfaces application note
(Keysight publication number 5991-2375EN).

Share, modify and transfer user-defined
applications and add-ins

UDA development environment is free to
download at www.keysight.com/find/uda. You
can create your UDA and shares your
application both on site or trans-regionally. You
can run as many UDAs on your oscilloscope as
you would like with one license.

You can find examples of UDA at:
www.keysight.com/find/share_uda.

You can also share the UDAs that you have
developed. You can download an example and
then modify the application to be the exact
application you need with one license.

Tools | Help

Manage » ]

File Edit Build

Command Files...

Debug Run 4 Connection Diagrams (HTML)...

Use thoso optiona t Generated App Compatibility... Connection Diagrams (images).

Send remote interfa
®fe: [ Options...

Scope Option Requirements... Console Applications...

External Application Scripts...

© Scipt:  # Sample Script using ATE Remote Scripting Lapguagé EBxternal Instruments...
B S RN AS2A Remore ookt for movs Womey  Intemal Variabls..
; : ) Math Libraries...
Stop gu?’?;egﬁgszl:gges sfm popping up during run AR
#TODO; Replace 1" with actual test IDis): separate mu Reserved Variables...

SelectedTests 1 Scope Mask Files...

Run Scope Setup Files...
# Other commonly used {remove '#f to enabl Switch Matrix
Text Libraries..
4 Transfer Function Files...

Build Summary: Fai (128 buid emors)

Buid | Find

Ready Infiniium Application
Figure 8. Switch matrix software enabled within UDA.

* Drag barto resize ~

N

1 S
Figure 9: automated testing for multi-lane digital bus interface

using our switching solution.
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Figure 10: UDA applications being shared on our Keysight
community forum.
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Ordering Information and Related Literature
Compatibility requirements

All listed firmware requirements are minimum, and any versions greater than listed can be used.

InfiniiVision Infiniium DCA
Family Firmware Family Firmware Family Firmware
1000 X-Series 1.10 9000 Series 6.30 FlexDCA 6.0
1200 X-Series 2.10 S-Series 6.30
2000 X-Series 2.40 90000 Series 6.30
3000T X-Series 7.10 V-Series 6.30
4000 X-Series 7.10 Z-Series 6.30
6000 X-Series 7.10 UXR-Series 10.0

Flexible Software Licensing and KeysightCare Software Support Subscriptions

Keysight offers a variety of flexible licensing options to fit your needs and budget. Choose your license
term, license type, and KeysightCare software support subscription.

License Terms

Perpetual — Perpetual licenses can be used indefinitely.

Time-based — Time-based licenses can be used through the term of the license only (6, 12, 24, or 36

months).

License Types :
KeysightCare Software Support

Node-locked — License can be used on one specified  Subscription provides peace of

instrument/computer. mind amid evolving technologies.
Transportable - Licens_e can be used on one Ensure your software is always current
instrument/computer at a time but may be transferred to with the latest enhancements and
another using Keysight Software Manager (internet connection measurement standards.

required). e Gain additional insight into your

USB Portable - License can be wused on one problems with live access to our team of
instrument/computer at a time but may be transferred to technical experts.

another using a certified USB dongle (available for additional e Stay on schedule with fast turnaround
purchase with Keysight part number E8900-D10). times and priority escalations when you
Floating (single site) — Networked instruments/computers need support.

can access a license from a server one at a time. Multiple
licenses can be purchased for concurrent usage.

KeysightCare Software Support Subscriptions

Perpetual licenses are sold with a 12 (default), 24, 36, or 60-month software support subscription. Support
subscriptions can be renewed for a fee after that.
Time-based licenses include a software support subscription through the term of the license.

Find us at www.keysight.com Page 8



Selecting your license

Step 1. Choose your software product (eg. D9010UDAA).

Step 2. Choose your license term: perpetual or time-based.

Step 3. Choose your license type: node-locked, transportable, USB portable, or floating.
Step 4. Depending on the license term, choose your support subscription duration.

Examples
If you selected: Your quote will look like:
D9010UDAA node- Part Number Description
locked perpetual D9010UDAA User Defined Application Software
license with a .
12-month support R-B5P-001-A Node-locked perpetual license
subscription R-B6P-001-L KeysightCare software support subscription, node-locked—12 months
D9010UDAA Part Number Description

transportable time- D9010UDAA User Defined Application Software
based 6-month

license R-B4P-001-F 6-months, node-locked KeysightCare software support subscription

To configure your product and request a quote:

http://www.keysight.com/find/software

Contact your Keysight representative or authorized partner for more information or to place an order:
www.keysight.com/find/contactus

Related literature

Type Description / URL
Brochure Infinilum S-Series (500 MHz to 8 GHz real time oscilloscope)
Brochure Infinilum V-Series (8 GHz to 33 GHz real time oscilloscope)
Data Sheet Infiniium UXR Series (13 GHz to 110 GHz real time oscilloscope) . ' .' .’ . * '.
- : '. - .. *
Brochure 30 Things Only Infiniilum Oscilloscopes Can Do A - s OA
. "
. ®
App Note Using Microwave Switches When Testing High Speed Serial Digital Interfaces 4 .. °
% WY
. ® o
. @ ®
s O
. . Y )
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